
CHAPTER 5
SEISMIC EVALUATION OF RC FRAMES 

WITHOUT INFILL WALLS

5.1 GENERAL REMARKS
The 2001 Bhuj earthquake of India was an eye opener. It made thousands 

of people lose their lives and rendered millions to lose their houses. The 

effect was so wide spread that it not only affected the people in the 

vicinity of the epicenter but those living in a metro city Ahmedabad, about 

250 km away from the epicenter were badly affected. One more time it 

revealed the inherent weakness lying in the concrete building which are 
not detailed as per ductile detailing. A major damage was observed in RC 

framed structures which were in the range of ground + three storey 

(G+3) to (G+7) storey. Further, these buildings were having a normal grid 

of 3m x 3m column spacing with a normal storey height of 3m.

Due to aesthetic considerations, the columns were generally 230mm wide 

in order to be flush with the 230 mm thick brick wall which is a standard 
building material used in India. Hence, keeping all these factors in mind, it 

is decided to study a typical RC building frame having these dimensions 

under pushover analysis and to report the findings in a systematic 

manner. It is also decided to study another structure having a panel size 

to be 3m x 4.5m to incorporate the effect of asymmetry. It is proposed to 

subject these two models to pushover analysis and compare their 

performance by using a commercial software SAP2000.
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5.2 STEPS FOR ANALYSIS THROUGH SAP2000
The following general sequence of steps are followed in performing a 

nonlinear static pushover analysis using SAP2000 software:

88



1. Create a model Keeping in mind that material nonlinearity and 

pushover analysis results are restricted to frame elements, although 

other element types may be present in the model.

2. Define the static load cases, like dead, live, etc. that are needed for 

use in the pushover analysis (Define > Static Load Cases).

3. Define any other static and dynamic analysis cases, like quake, 

response spectrum, etc, that may be needed for steel or concrete 

design of frame elements.

4. Define the pushover load cases (Define > Static Pushover Cases).

5. Define hinge properties (Define > Hinge Properties).

6. Assign hinge properties to frame elements (Assign > Frame > Hinges 

(Pushover)).

7. Run the basic linear and dynamic analyses (Analyze > Run).

8. If any concrete hinge properties are based on default values to be 

computed by the program, one must perform concrete design so that 

reinforcing steel is determined (Design > Concrete Frame Design > 

Start Design/Check of Structure).

10. Run the pushover analysis (Analyze > Run Static Pushover).

11. Review the pushover results (Display > Show Static Pushover Curve), 

(Display > Show Deformed Shape), (Display > Show Element 

Forces/Stresses > Frames...), and (File > Print Output Tables... Frame 

forces in spreadsheet format).

12. Revise the model as necessary and repeat.

5.3 MATHEMATICAL MODELS DEVELOPED
There are two mathematical models developed for a Ground + 6 storey

(G+6) RC space frame. Figure 5.1'shows an isometric view of the two

models considered: a) with an overall plan dimensions of 6m x 6m and b)

with plan dimensions as 6m x 9m overall.
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a) G+6 with 3m x 3m panels b) G+6 with 3m x 4.5m panels
Fig. 5.1 The Models Considered for Pushover Analysis

Typical plan views of the 6m x 6m and 6m x 9m overall dimension models 

are as shown in Fig. 5.2.

Fig. 5.2 Plan View Showing Orientation of Rectangular Columns
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5.3.1 Geometry and Loads Considered
Panel size = 3m x 3m 

Number of panels in each direction = 2 

Overall plan dimension = 6m x 6m 

Storey height = 3m

Column size = Rectangular columns - 230mm x 450mm

Equivalent square columns - 322mm x 322mm 

Beam size = 230mm x 450mm

The loading is considered as follows:
Dead load : on typical floors 4 kN/sq.m., on terrace floor 6 kN/sq.m.

Live load : on typical floors 2 kN/sq.m., on terrace floor 1.5 kN/sq.m.

Wall load of 20 kN/m is considered on all peripheral beams of typical 

floors and it is considered as 6 kN/m on the terrace floor peripheral beams 

to account for parapet wall. The columns are extended for 3m below plinth 

level and are considered as fixed at the foundation level. The lateral loads 

due to earthquake are considered in the two lateral directions X and Y as 

per the method given in IS 1893 (Part 1) : 2002 [24]. The building is 

considered to be located in zone III as per the code with an importance 

factor of 1 and a response reduction factor of 3.

The static analysis is carried out with following four basic load cases :

1. Dead Load (DL) 2. Live load (LL) 3. Earthquake load X (EX) and 

4. Earthquake load Y (EY).

5.3.2 Defining the Pushover Load Parameters
There are four categories of default plastic hinges defined in the software. 

They are: i) The axial hinge (P), ii) The flexural hinge corresponding to M3
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moment (M), iii) The shear hinge (V) and iv) The combined axial (P) and 

flexural hinges (M2 & M3) designated as PMM hinge. To understand the 

behavior of the considered 3D RC frame, all the four types of hinges are 

defined at the ends of all beams and columns. A separate account is kept 

for the development of each of these hinges when a push is given. There 

are two lateral push defined in the X and Y direction. First, a push is given 

in the gravity direction up to the full magnitude of dead and live load. 

Later, a lateral push is given in each of the plan directions, i.e. X and Y 

defined as PUSH1 and PUSH2 which are displacement controlled. The 

target displacement is defined as 4% of the building height.

The values of SA and SD are noted at each step of the lateral push and a 

capacity spectrum in ADRS format is plotted. This spectrum is converted 

into a bilinear curve as per the procedure mentioned in ATC-40 [1]. The 

demand spectrum based on the design response spectrum given in 
IS 1893 Part 1 : 2002 [24], is also constructed in the ADRS format and it 

is plotted as a reduced demand spectrum on the same plot as the capacity 

spectrum. The intersection point of the reduced demand spectrum with 

the capacity spectrum, known as the performance point is evaluated and 

reported. The mathematical steps are given in the next section.

5.4 RESULTS OF THE PUSHOVER ANALYSIS
The static analysis is carried out in SAP2000 for the four basic load cases. 

In all 13 load combinations as prescribed in IS-1893 Part 1, 2002 are 

defined. Design of all the beams and columns of the frame is carried out. 

Next, pushover analysis is carried out as per the three pushover cases 
defined in 5.3.2 above. Th4 results for rectangular columns are noted 

down from the software in a tabular form as given in Table 5.1 and the 

same is represented in the bilenearform in Fig. 5.3.
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Table 5.1 Capacity Curve values for Rectangular Columns

Displacement
Droof in mm

Base Shear
V kN

Sa
(g)

Sd

mm
0.00 0.00 0.00 0.00
10.00 703.92 0.09 7.87
20.00 1402.73 0.17 15.83
30.00 2096.46 0.26 23.70
40.00 2437.17 0.30 27.56
50.00 2976.56 0.36 ' 35.75
60.00 3357.83 0.41 45.75
60.00 3396.05 0.41 47.32
60.00 3399.23 0.42 47.48
60.00 3400.49 0.42 47.64
70.00 3276.90 0.40 55.51
80.00 3164.93 0.39 63.39
90.00 3059.42 0.37 71.18
100.00 2964.44 0.36 78.66

In Table 5.1, Sa=(V/W*a), Sd=Dr0of/PFjzS,PF=9.53 (Modal Participation 

factor), a=0.75 (Modal Mass coefficient for the 1st natural mode), 

<D=0.134 (Amplitude of mode 1 at roof) and W= 10920 kN (Weight of the 

building).

Fig. 5.3 Capacity Curve for Rectangular Columns
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The values of ay, api, dy and dpi extracted from Fig. 5.3 are used to 

reduce the initial demand spectrum given in IS 1893 for 5% damping and 

the values are presented in Table 5.2.
Table 5.2 Demand Curve Values for Rectangular Columns

Original Demand Reduced Demand

Sa in g Sd in mm Sa in 9 Sd in mm
1.15 ' 0.03 1.00 0.00
1.30 0.13 1.15 0.03
1.45 0.33 1.30 0.13
1.60 0.64 1.45 0.33
1.75 1.09 . 1.60 0.64
1.90 1.71 1.75 1.09
2.05 2.51 1.90 1.71
2.20 3.52 2.05 2.51
2.35 4.76 2.20 3.52
2.50 6.25 2.35 4.76
2.50 25.00 0.83 8.25
2.50 56.25 0.83 18.56
2.50 100.00 0.83 33.00
2.50 156.25 0.83 51.56
2.50 189.06 0.83 62.39
2.26 203.40 0.83 101.70
1.94 237.65 0.83 118.83
1.70 272.00 0.83 136.00
1.51 305.78 0.76 152.89
1.36 340.00 0.68 170.00
0.68 680.00 0.34 340.00
0.45 1012.50 0.23 506.25
0.34 1360.00 0.17 680.00

Thus, it is seen that as the pushover proceeds into inelastic zone, and as 

the plastic hinges get developed in the members of the structure, the 

inherent damping increases from 5% to higher values, thus reducing the 

demand on the structure. The plot of capacity spectrum in ADRS format as 

in Fig. 5.3 is superimposed on the demand spectrum in Fig. 5.4. The 

intersecting point of capacity spectrum and the demand spectrum is 

known as the performance point. The damping is evaluated using the
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relations given by Eq. 4.5 and Eq. 4.7. This will yield the performance 

point for the model of G+6 frame having rectangular shaped columns. It is 

seen from the plot of Fig. 5.4 that the capacity spectrum does not 

intersect demand spectrum and hence the performance point does not 

exist for this mathematical model.

Fig. 5.4 Performance Point for Rectangular Columns

A similar procedure is carried out for equivalent square columns, where 

the size of the square columns is evaluated by keeping the same cross 

sectional area as that of rectangular columns. Thus, an equivalent square 
column for a rectangular column of 230 mm x 450 mm works out to be 

sqrt (230 x 450) = 322 mm. The capacity curve for square columns is 

based on the values evaluated from the SAP2000 software which is
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presented in Table 5.3. Based on these values, a capacity spectrum in a 

bilinear form is drawn as depicted in Fig. 5.5.

Table 5.3 Capacity Curve values for Square Columns

Displacement
Droof in mm

Base Shear
VkN

Sa
(9)

Sd

mm
0.00 0.00 0.00 0.00
12.31 869.91 0.20 8.80
24.63 1735.37 0.40 17.59
36.94 2596.39 0.59 26.39
49.26 3452.99 0.79 35.19
61.57 4305.18 0.99 43.98
73.89 5152.98 1.18 52.78
83.84 5838.21 1.34 59.89
98.46 6805.90 1.56 70.33
110.87 7511.15 1.72 79.19
123.11 8062.15 1.85 87.94

In Table 5.3, PF = 9.87, a = 0.79, 0 = 0.132 and W = 10920 kN

Fig. 5.5 Capacity Curve for Square Columns
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The values of ay, api, dy and dpi which are noted from Fig. 5.5 are used 

to develop the reduced demand spectrum whose values are given in

Table 5.4.

Table 5.4 Demand Curve values for Square Columns

Original Demand Reduced Demand
_ . *„• iSaKtniil^ Sd in mm Sain g. Sd in mm

1.15 0.03 1.00 0.00
1.30 0.13 i.15 0.03
1.45 0.33 1.30 0.13
1.60 0.64 1.45 0.33
1.75 1.09 1.60 0.64
1.90 1.71 1.75 1.09
2.05 2.51 1.90 1.71
2.20 3.52 2.05 2.51
2.35 4.76 2.20 3.52
2.50 6.25 2.35 4.76
2.50 25.00 0.83 8.25
2.50 56.25 0.83 18.56
2.50 100.00 0.83 33.00
2.50 156.25 0.83 51.56
2.50 189.06 0.83 62.39
2.26 203.40 0.83 101.70
1.94 237.65 0.83 118.83
1.70 272.00 0.83 136.00
1.51 305.78 0.76 152.89
1.36 340.00 0.68 170.00
0.68 680.00 0.34 340.00
0.45 1012.50 0.23 506.25
0.34 1360.00 0.17 680.00

The superimposed plot of capacity spectrum on the original 5% damped 

and reduced demand spectrum calculated using Eq. 4.5 is presented in 

Fig. 5.6. It is seen from this plot that the reduced demand spectrum 

intersects the capacity spectrum at a point which is the performance 

point. Thus, the performance point in the ADRS format is represented as 

(35, 0.8g).
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Fig. 5.6 Performance Point for Square Columns

Moreover, another comparison between the performance of rectangular 

(R) and square (S) columns is made by noting down the data for the 

plastic hinges developed in column elements and beam elements. The 

number as well as stress level of the hinges is an indication of the 

performance of the building. Under these circumstances, a detailed 

account of number of hinges developed and it's corresponding stress level 

is presented for square and rectangular columns.

This comparison is presented in Tables 5.5 and 5.6 for hinges developed 
in beams and columns in both the models and it is also represented 

graphically with colour coded hinges in Figs. 5.7 and 5.8. The final 

deformed shapes of both the models having rectangular and square 

columns with colour coded hinges is shown in Fig. 5.9.
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Table 5.5 Beam Hinges Developed in R and S Column Models

H
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sh
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ir.

Category of hinges

B-IO IO-LS
LS-

CP
CP-C C-D D-E TOTAL

Disp. in

mm
R s R S R s R s R s R s R S R S

M X 9 4 0 1 2 0 0 0 1 1 0 0 12 6 0.24 7

M Y 9 6 1 0 0 0 0 0 0 0 0 0 10 6 40 9

PMM X 4 4 1 3 1 3 0 0 0 0 0 0 6 10 0.25 28

PMM Y 4 14 0 3 2 1 0 0 0 3 0 0 6 21 48 31

V X 1 1 0 0 0 0 0 0 1 1 0 0 2 2 0.29 29

V Y 3 32 1 18 0 2 0 1 0 0 0 0 4 53 60 60

P X 0 0 36 0 12 0 12 0 8 0 0 0 68 0 3.6 60

P Y 0 0 0 0 0 0 0 0 0 0 0 0 0 0 60 60
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Fig. 5.7 Hinges Developed in Beams for Push in X-Direction
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NUMBER OF VARIOUS CATEGORY OF HINGES IN THE COLUMNS

R RECTANGULAR 

S SQUARE

PMM
CATEGORY OF HINGES

!() LS CP CD

Table 5.6 Column Hinges Developed in R and S Column Models

Fig. 5.8 Hinges Developed in Columns for Push in X-Direction
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ir. Category of hinges Displ.

in mmB-IO IO-LS LS-CP CP-C C-D D-E TOTAL

R S R s R s R s R s R s R S R S

M X 88 4 0 1 0 0 0 0 0 2 0 0 88 7 3.05 7

M Y 0 6 0 0 0 0 0 0 0 0 0 0 0 6 60 6

PMM X 26 1 4 1 15 1 0 0 0 0 0 0 45 3 1.31 33

PMM Y 0 0 0 0 0 0 0 0 0 0 0 0 0 0 60 28

V X 4 1 16 0 0 0 4 0 4 1 0 0 28 2 31 29

V Y 0 1 0 0 0 0 0 0 0 1 0 0 0 2 60 30

P X 0 0 2 0 0 0 0 0 2 0 0 0 4 0 1.6 60

P Y 0 0 0 0 0 0 0 0 0 0 0 0 88 0 60 60
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Mtf,

a)Rectangular Columns b)Square Columns

10= Immediate Occupancy, LS = Life Safety, CP = Collapse Prevention

Fig. 5.9 Hinges Developed in R & S Models under Push in X-Direction

One more important factor under lateral loads which is directly related to 

the performance of a structure is the storey drift. The drift values for the 

square and rectangular columns for the 3m x 3m panel size are presented 

in Table 5.7 and the corresponding plot is presented in Fig. 5.10.

Table 5.7 Storey Drift for R & S Models under Push in X-Direction

Storey
Level

Drift in mm
Square Columns Rectangular Columns

7 6.09 2.02
6 9.92 3.74
5 13.67 5.47
4 17.04 7.88
3 20.33 11.46
2 23.15 59.36
1 21.71 9.44
0 11.21 2.11
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—♦—Square Columns —■—Rectangular Columns

Fig. 5.10 Storey Drift for R & S Models under Push in X-Direction

Similar observations are made for a panel size of 3m x 4.5m with a G+6 

storey space frame. The mathematical model developed for the same is 

shown in Fig. 5.1 b). The results obtained in terms of capacity spectra 

along with bilinear representations are presented. The capacity values to 

construct the capacity curve for bilinear representation for rectangular 

columns, noted from the output of SAP2000 software, are presented in 

Table 5.8. The bilinear curve is drawn in Fig. 5.11 and all relevant values 

are calculated from the same.

Table 5.8 Capacity for Rectangular Columns with 3 m x 4.5 m panel

Displacement 
Droof in mm

Base Shear
V kN

Sa
(g)

Sd
mm

0 0 0 0
3.38 11533.44 1.1 2.68
4.38 14527.97 1.38 3.47
5.48 16166.25 1.54 4.35

22.01 25292.6 2.4 17.47

Pf = 0.34, a = 0.76, (D = 3.71 and W = 13854 kN
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Spectral Displacement Sd in mm

Fig. 5.11 Bilinear Curve for Rectangular Columns

From bilinear curve, api = 2.4, ay = 1.5, dy = 4, dpi = 17.46

Beq = Po+5 = 0.637{(ay*dpi-dy*api)}/api*dpi+5 = 25.21 + 5 = 30.21

From ATC 40, Sra = 0.4 and SRV = 0.55

The relevant values of effective damping are evaluated and are used to 

reduce the demand spectrum for rectangular columns. The values for 

constructing the reduced demand spectrum are presented in Table 5.9 
and the plot of capacity spectrum superimposed on reduced demand 

spectrum to get the performance point is shown in Fig. 5.12.

The performance point obtained from Fig. 5.12 for a 3m x 4.5m panel 

size with rectangular columns in ADRS format is (2.5, lg).
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Table 5.9 Reduced Demand Values for Rectangular Columns

Original Demand Reducec Demand
Sa in 9 ; Sd in mm Sd in mm

1.15 - 0.03 0.46 0.01
1.30 0.13 0.52 0.05
1.45 0.33 0.58 0.13
1.60 0.64 0.64 0.26
1.75 1.09 0.70 0.44
1.90 1.71 0.76 0.68
2.05 2.51 0.82 1.00
2.20 3.52 0.88 1.41
2.35 4.76 0.94 1.90
2.50 6.25 1.00 2.50
2.50 25.00 1.00 10.00
2.50 56.25 1.00 22.50
2.50 100.00 1.00 40.00
2.50 156.25 1.00 62.50
2.50 189.06 1.00 75.63
2.26 203.40 0.90 81.36
1.94 237.65 1.07 130.71
1.70 272.00 0.94 149.60
1.51 305.78 0.83 168.18
1.36 340.00 0.75 187.00
0.68 680.00 0.37 374.00
0.45 1012.50 0.25 556.88
0.34 1360.00 0.19 748.00
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The same mathematical model with square columns is subjected to push 
over analysis in SAP2000 and the values for constructing the capacity 
curve is noted down in Table 5.10. Based on this, a bilinear curve is 
drawn in Fig. 5.13.

Table 5.10 Capacity for Square Columns for 3m x 4.5m panel

Displacement 
Draof in mm

Base Shear 
V kN

Sa
(g)

Sd 
mm.

0.00 0.00 0.00 0.00
4.04 13998.07 1.28 3.16
6.04 20219.59 1.85 4.72
7.82 22990.30 2.10 6.11
14.03 26288.12 2.40 10.96

In Table 5.10, PF=0.35, a = 0.79, O = 3.66 , W = 13854 kN

Fig. 5.13 Bilinear Curve for Square Columns
From the bilinear curve, the value of api = 2.4, ay = 2.1, dy = 5, dpi = 11 
Beq = po+5 = 0.637{(ay*dpi-dy*api)}/api*dpi+5 = 12.5 + 5 = 17.5
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From ATC 40, Sra = 0.55 and SRV = 0.65

The above values are used to reduce the demand spectrum specified by 

the code as per ATC 40 provisions. The values for the initial demand 

spectrum and the reduced demand spectrum for this particular model are 

presented in Table 5.11, whereas Fig. 5.14 shows the superimposed plot 
of capacity and reduced demand spectrum for the model with square 

columns. The intersection of the reduced demand with the capacity 

spectrum in the ADRS format represents the performance point which 

comes out to be (3.35, 1.35g) in the ADRS format.

Table 5.11 Reduced Demand Values for Square Columns

Original Demand Reduced Demand If

Sa inskskl Sd in mm Sa in k9 Sd in mm
1.15 0.03 0.46 0.01
1.30 0.13 0.52 0.05
1.45 0.33 0.58 0.13
1.60 0.64 0.64 0.26
1.75 1.09 0.70 0.44
1.90 1.71 0.76 0.68
2.05 2.51 0.82 1.00
2.20 3.52 0.88 1.41
2.35 4.76 1.29 2.62
2.50 6.25 1.38 3.44
2.50 25.00 1.38 13.75
2.50 56.25 1.38 30.94
2.50 100.00 1.38 55.00
2.50 156.25 1.38 85.94
2.50 189.06 1.38 103.98
2.26 203.40 1.24 111.87
1.94 237.65 1.26 154.47
1.70 272.00 1.11 176.80
1.51 : 305.78 0.98 198.75
1.36 340.00 0.88 221.00
0.68 680.00 0.44 442.00
0.45 1012.50 0.29 658.13
0.34 1360.00 0.22 884.00
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Fig. 5.14 Performance Point for Square Columns

The drift values for both square and rectangular column models are 

reported in Table 5.12 and the corresponding plot is presented in 

Fig. 5.15. Figure 5.16 shows the hinges developed at performance point 

for both the models.

Table 5.12 Drift Values for R and S Columns

Column RECTANGULAR SQUARE
Storey Level Drift (X) Drift (X)

7 0.97 0.97
6 2.12 1.54
5 3.33 2.00
4 4.15 2.33
3; 4.41 2.35
2 4.22 2.24
1 2.42 2.06
0 0.00 0.00
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—*— Rectangular Column Square Column

Fig. 5.15 Storey Drift for R and S Models under Push in X-Direction
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Fig. 5.16 Hinges Developed in R & S Models - Push in X-Direction

5.5 DISCUSSION OF RESULTS

1. For the panel size of 3m x 3m, it can be seen that there is no distinct 

performance point observed for rectangular columns whereas the 

square columns show a distinct performance point.

Ec,4->

~
8

CD r~t
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2. The hinges developed in the rectangular column model for the 3m x 3m 

panel size are more in number as well as severe in nature. This is 

evident from Fig. 5.7 and Fig. 5.8.
3. The deformed shape of both the models under a lateral push as shown 

in Fig. 5.9 clearly indicates that there is an alarming lateral 

deformation in the model with rectangular columns. This is an 

indication that under similar seismic situations, a building with square 

columns will perform better.

4. Figure 5.10 indicates that for the model with rectangular columns, 

there is an excessive drift at the first storey level which indicates a 

poor performance. The model with square columns shows a uniform 

variation in drift which signifies a better seismic performance.

5. For the 3m x 4,5m model, it can be seen that a performance point is 

achieved in both the models. Although the square shaped columns 

shows a slightly better performance, the performance of both the 

models are comparable.

6. The plot of storey drift in Fig. 5.15 for 3m x 4.5m panel shows that 

square shaped columns exhibit a less storey drift as compared to 

rectangular columns. This is a clear indication of a better seismic 

performance by square shaped columns.

7. The final deformed shape with colour coded hinges shown in Fig. 5.16 

for square column depicts fewer hinges and with lower stress value as 

compared to the rectangular columns.
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